
MacDraft™ Release Notes

This document contains the release notes for all versions of MacDraft after version 4.2.2.

Version 5.5 (12 September 2003)

New features

New features have been added to Microspot MacDraft 5.5 to enhance performance and improve
image and text quality.  Features include Quartz Graphics with transparency, ATSUI text, import
picture as well as the ability to use the resize palette with pixel maps and paragraph text.  These
features combined make MacDraft 5.5 a superior product for CAD and graphic design.

Quartz Graphics - MacDraft now uses Quartz Graphics, the native graphics engine for OS X.
The result is improved filling of curved shapes, superior line quality that now makes it possible
to see the difference between hairlines and one-point lines on screen.

Transparency - Transparency has been added and can be applied to lines, fills, double line
fills, text and pictures with an opacity range of 0-100%.

ATSUI Text - ATSUI (Apple Type Services for Unicode Imaging) text allows for the inclusion of
the Unicode character set.  This maintains superb quality of text even when rotated.

Import Picture - Import Picture has been added to allow the import of PICT, TIFF, GIF,
JPEG/JFIF and Windows BMP formats.  The pictures can then be resized and rotated to any angle
and made transparent.  The memory efficiency of picture handling has improved resulting in
smaller files and faster operation.

Resize Palette - The resize palette now works with pictures and text as well as shapes.

Multiple Undos - 100 levels of undo have been added allowing the user to easily correct
mistakes or try variations on their drawing.

Compatibility with Adobe Illustrator - MacDraft files can now be made compatible with
Adobe Illustrator by converting files to PDF using the Print to PDF command.  The file can then
be opened and edited in Adobe Illustrator.

Version 5.1.1 (11 June 2003)

Bug fixes

1.  Reading of DWG files with some constructs is improved.
2.  When applying a mirror tool to a ninety degree arc to mirror it about a horizontal line, the
widgets appear in the right place but the arc itself is misplaced.
3. A very obscure and only occasionally reproducible crash on opening 1-bit raster images.
4. Pasting of shape into and then out of a symbol library causes its size change.
5. Files with text that were created with the PC Draft versions released after February, 19, 2003
are now opened properly.

Version 5.1 (31 October 2002)

New Features

1.1. Automatic .dwg scaling.
1.2. Further improved the DWG/DXF import by using the OpenDWG Toolkit libraries.
1.3. Support for Mac OS X 10.2 (Jaguar).
1.4. Minor bug fixes.

Version 5.0 (23 May 2001)



New Features

1.1. Added linked dimensions.
1.2. Linked and unlink vertex tool in accessories palette.
1.3. Further improved the DWG/DXF import by using the OpenDWG Toolkit libraries.
1.4. Added Balloon help on most menus and tools.
1.5. Added an angular grid, use the shift key turns this off during entry.
1.6. Added Navigation services for open and save dialogs
1.7. Can open Microspot Librarian or Microspot Media Assistant files from the open menu.
1.8. Attribute popup menus from bottom of window
1.9. Magnification feedback now has popup at bottom of window
1.10. Show cursor position area now popups palette menu
1.11. Option close closes all documents
1.12. Select layer tool hilites when clicked to show you are in that mode
1.13. All previously modal dialogs made movable modal
1.14. Can show areas on Metapolygons
1.15. Can resize groups by X and Y as well as percent in the resize palette
1.16. Added crop marks if required to edge of printed paper as Dreams used to
1.17. Move Object dialog has Apply button as well as Move button
1.18. Cross hairs when resizing objects if cross hairs are turned on
1.19. If you double click a file in the Finder will bring that document's window to the front if it
is already open.
1.20. Save grid snapping values in preferences, especially if grid snap is set to none
1.21. Duplicate with control key down will now not duplicate locked objects.
1.22. Control-option-click with arrow tool selects layer of object clicked on.
1.23. Option key down on entering dimensions toggles format to 'arrows inside'.
1.24. Control key down on entering dimensions make the dimension line a hairline.
1.25. MacDraft 5.0 files are interchangeable with PC Draft 4.3.5 and later.

Palettes

2.1. Added a new Alignment Palette
2.2. Attribute palette shows current settings
2.3. Attribute palette has new parallel line fill which can be hidden with zoom box
2.4. Arrow head popup menu selects whole line if cursor in middle of line item and draws with
correct feedback
2.5. Dimension Palette now has zoom box to hide bottom items so can be used on a 640x480 screen
2.6. Symbol library palette and window now moved in unison so that switching between modes
does not cause palette/window to move around the screen unexpectedly.

Menus

3.1. Added Palettes to Windows menu
3.2. Added option to Tile and Stack Windows
3.3. Expand and Contract object menus

Tools

4.1. Repeated paste tool
4.2. Edit Datum tool
4.3. Rotate tool
4.4. Hand tool
4.5. Inclusive and exclusive marquee selection tools
4.6. Tool Options menu item
4.7. Eye dropper tool works with parallel fill attributes
4.8. Eye dropper is now undoable

Drawing

5.1. Created 3 line types (square, blade, and round)
5.2. Can now draw double lines off double lines without having to break up first
5.3. Bezier has rubber deletion facility of freehand polygon



5.4. Bezier gives feedback with mouse up. Also only shows first and current bezier tangents
5.5. Backspace deletes last point of polygons, splines or beziers
5.6. Shift key unlocks constrained lines on entry
5.7. Shift key constrains Rects, Elipses and Rounded Rectangles when resizing
5.8. Calculate arc bounds differently if filled or not filled
5.9. Pictures and text can be flipped
5.10. Pictures support no fill option and filled backgrounds
5.11. Curved dashed lines now drawn much better.

Text

6.1. Text services at bottom of Text menu for spell checkers and grammer checkers
6.2. Text can be vertically aligned
6.3. Text size now up to 1024 point
6.4. Text size menu now reflects the selected text
6.5. Text popup menu off text tool
6.6. Zoomed in small rotated text drawn MUCH better
6.7. Select a rectangle and start typing inserts a new text object. Rectangle is automatically
linked to this new text object.
6.8. Click on selected text object to start editing
6.9. Handles work on caption text tools to resize font size
6.10. When changing scales, any text objects can either be scaled or not.

Bug fixes

1. Arrange menu in Layer dialog did not work first time
2. Now saves document and palette window size and position if saved on second screen
3. Now zooms document and palette windows correctly on multiple monitors
4. Show area menu greying has been corrected
5. If show area on an object, the info palette showed nothing
6. Holding shift key down AFTER editing bezier straightens handles
7. Command click in Edit datum mode exits that mode
8. Command click with eye dropper and marker tool goes back to arrow tool
9. Dimensioning did not print on a second page of a high res printer
10. Area fills were missed out after certain lengths on a high resolution printer
11. Corrected inaccuracies in bounding rectangles
12. Metapolygons calculate extents correctly
13. Speed up in redraws
14. Linear duplicate framed a rounded rectangle when clicking two directions radio button
15. Edit Datum only greyed in when one object selected
16. Resizing polygons left ghosts if you had smooth text on.
17. Zoom line weights did not differenciate between 0.75, 0.5 and hairline if zoomed in.
18. Dashed arcs and circles draw MUCH better.
19. Easier to select an arc segment when zoomed in.
20. Find/Replace. The replace with Use mouse will not find items with a blank string
21. Duplicate with no offset will not move view at high magnifications.
22. Do not unconstrain angle constrained lines unless user types in a different angle.
23. Added "including original" text into the copies item in the linear and circular duplicate
dialog
24. Removed 'by center' and 'by datum' radio buttons in duplicate dialog as did the same thing
25. Document Shift Page Up and Page Down does Page Left and Page Right.
26. Using the arrows keys after a duplicate now updates the duplication offset for further
duplications.

Version 4.4 (7th January 2000)

New Features

Made MacDraft MacOS 9 compatible.

MacDraft saves and reads PCDraft exchange format.



MacDraft reads and writes DWG files if the DWG File Exchange library is present.

Export file command in File menu using QuickTime Graphic Exporters to save as JPEG, BMP etc.

Selecting New from the File menu selects New Document.

Added Register and Upgrade Information menus items in Help menu.

Added Command U back to Ungroup. Command-Shift-G is still valid.

Command-Shift-D duplicates with no offset.

MacDraft requires a serial number that matches the version.

The Reopen Application Apple Event implemented so MacDraft will open a new document if no
document is open on double-clicking the application in the Finder.

MacDraft will now read future versions of MacDraft files but not display unknown objects. They
will be saved back when written back to a file.

Bugs Fixed
Fixed overflow bug which resets to origin when zooming out from a large document at a large
scale.

When zooming windows on multiple monitors, the window will zoom to the size of the monitor
that it is on, not to the main screen.

If saving a document which is not on the main monitor, MacDraft will now open it again in the
correct position and not on the main monitor.

Added 'open' and 'kind' resources.

Grey out Select All Text menu if entering text.

Does not crash after reading DXF files.

Version 4.3.1 (29th July 1999)

New Features
The MacDraft PDF documentation can now be accessed from within MacDraft using the system
wide Help menu.

Improved Functionality
DXF importing is now much more robust and able to cope with files created with Revision 14 of
the DXF specification. 

Opening files (especially PICT) is now much faster.

Bugs Fixed
Fixed a crashing bug that could sometimes occur when opening a MacDraft Symbol Library.

When creating PICTs (either via the Clipboard, Drag & Drop or saving to a PICT file) the colors
of objects saved in the PICT were subtly different to those in the original document. This meant
that if that same PICT was later re-imported into MacDraft, those colors would probably not
match 'equivalent' colors in MacDraft’s standard color table, and hence could not be selectable
from the Fill or Pen Color pop-up menu. This problem was compounded by the following bug...

MacDraft documents saved with additional colors to those in MacDraft’s standard color table
would lose those colors when the document was reopened. Items that used those colors would
then be drawn in black (or random colors). This and the previous bug have existed in all
versions of MacDraft since at least version 4.2.2 (and probably earlier). We are amazed that
they have gone unnoticed for so long.



Version 4.3v4 (30th April 1999)

Bugs Fixed
Fixed a crashing bug that could sometimes occur when opening a MacDraft Symbol Library.

Version 4.3v3 (10th August 1998)

Bugs Fixed
Fixed FAXstf™ conflict. If the user cancelled the FAXstf password dialog that is displayed after
choosing Print from MacDraft, the program would sometimes crash.

Version 4.3v2 (1st July 1998)

New Features
Added 'Select Arrow Tool' and 'Select Zoom Tool' menu commands to the Palettes submenu. Their
command key equivalents are Command-` and  Command-Shift-` respectively. These commands
can also be assigned to a ShortKey of your choice.

Improved Functionality
ShortKeys menu. As well as assigning commands to the function keys F5 to F15, you can now
also assign commands to Shift-F5 to Shift-F15.
E.g. To assign a command to Shift-F5, press Control-Shift-F5.
(This feature was actually present in MacDraft 4.3, but was never documented anywhere.
Congratulations if you had already found it.)

When opening documents which use unavailable fonts, MacDraft now retains the original font
information for text objects unless the user explicitly changes it. Although any text using
missing fonts will display incorrectly, if the document is saved and then opened on a computer
where the font is available, it will display correctly. To determine if a document uses any
missing fonts look at the Font menu; missing fonts will be displayed dimmed above the installed
fonts. 

Bugs Fixed
Fixed crashing bug when attempting to use Command-key equivalents of some menu items
when no documents are open.

MacDraft is now usable if you have no printer driver chosen.

When doing free rotations in minutes or seconds it now possible to step back to degrees or
minutes using the Command key. This feature went missing in MacDraft 4.3.

When opening documents saved on other computers, MacDraft could get confused about which
fonts to use, even if the same fonts existed on both computers.

Version 4.3v1 (June 1998)

This version was never released externally. 

Version 4.3 (17th April 1998)

There are many improvements and new features in MacDraft 4.3. For a full description of these,
please read the printed ‘User Guide Addendum’.

The following is a brief description of the main changes.

Existing users who wish to get started straight away should, at least, read section 7 of the



addendum for important changes to the Command-Key equivalents of MacDraft.

Late Breaking News
This section deals with features that are not mentioned in the addendum, or have changed since
it was printed.

The addendum refers to a sample Librarian file called ‘Furniture Library’; this file has been
renamed to ‘MacDraft™ Libraries Sampler’.

Added a Close All command (Command-Option-W). This will close all of the open MacDraft
document windows.

The Align command has been renamed to Align Again to better clarify its meaning. This
command allows you to align objects using the settings previously defined in the Alignment
Options dialog.

New Features
Drag and Drop support. Objects can now be dragged in and out of MacDraft document windows,
both from other MacDraft windows and other applications.

ShortKeys Menu. This menu allows you to assign your most commonly used menu commands to
the function keys (F5 - F15).

Rotate 90° Tool. This new tool allows a quick means of doing 90° rotations to the selected objects.

Attributes Tool. This tool allows you to copy and apply attributes in the same way as using the
Copy Attributes and Apply Attributes menu commands.

Marquee Zoom. The zoom tool now allows you to drag out an area to zoom in on.

Cancellable actions. Most drawing actions (ie creating and modifying objects) can now be
aborted using Escape or Command-Period.

Improved Functionality
Improved layout of many alerts and dialog boxes.

Alignment Options now supports a wider range of options.

‘Command-Click’ shortcuts that were used to exit the current drawing tool have been removed.
You can now use the new Escape or Command-Period keyboard shortcuts. This now allows the
Command key to be used to temporarily turn off the grid snapping while using the drawing
tools.

PICT support has been dramatically improved, MacDraft documents saved as PICT should no
longer lose any information(*) when reopened in MacDraft (assuming that they haven't been
edited somewhere else first). Full MacDraft PICT compatibility is required, as it is used by Drag
and Drop for external data.
(*)The two known outstanding exceptions to this are - Areas and Point to Point dimension lines.
Areas will lose their links to the parent object, and Point to Point dimension lines will be
broken into Text and line objects. We will be addressing these problems in a future release of
MacDraft.

The icons used by the Finder have been improved and now include small versions. (You may
need to rebuild the desktop database to see the changes, by holding down the Command and
Option keys when the Finder launches at the end of startup.)

On-screen display of rotated text has been improved to remove unwanted visual artifacts. It is
also drawn up to twice as fast as previous versions.

The state of the Absolute/Relative mode in the Move dialog is now remembered for subsequent
openings of the dialog.



Preview images are now added when saving in MacDraft or PICT format (requires QuickTime™).

The standard Open dialog supports file previews (requires QuickTime).

MacDraft now makes more use of the system’s Temporary memory to reduce the chances of
running out of memory.

DXF reading code has been improved to better support files from PCs. Please see the separate file
for further DXF info.

When auto-scrolling a MacDraft window during a drawing operation, the maximum scroll speed
is now pinned to something more manageable on modern computers.

The Escape key can now also be used in places where Command-Period is used as a means of
cancelling.

Invisible files are no longer displayed in the standard Open dialog.

The selected format is now remembered between uses of the Open dialog, and it has been
defaulted to ‘MacDraft’ instead of ‘All’.

The pattern editor can now be used on 16 and 32 bit monitors. It has also been enhanced.

Saving files (especially PICT) is now much faster.

Bugs Fixed
Fixed crashing bug under Mac OS 8 when the System Wide Appearance setting was off.

Now disallow any shapes that have an attached 'Area Calculation' from being added to other
shapes. Previously it was possible, using the Add Tool,  to add a shape that was showing its area -
this resulted in the area becoming detached from the original shape (which in fact had been
deleted) and the program would crash if the area was clicked-on.

Opening MacDraft 3.0 files that contained an empty text object caused a crash when the object
was part of a group.

Switching between the different Unit Standards often resulted in objects being the wrong size.
i.e. something that was drawn as 1" in decimal inches did not get changed to 2.54cm when the
units were changed to Metric cms.  There was a similar problem when changing from decimal
feet to another units setting.

Objects pasted between documents with different 'Unit' formats are now scaled correctly - this
was not always the case previously, especially when one of them was using decimal feet.

Paper sizes were being calculated wrongly for some printer drivers (especially the
ImageWriter).

Numerous minor bugs have been fixed.

Eliminated all known memory leaks 
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